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Details of the
Requirements Analysis Process
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|. Third week material:
A. Milestone 2 writeup and example.

B. Requirements document HTML standards.
C. Cornventions for standardized GUIs.

D. These lecture notes.
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Summary of Milestone 2 Deliver ables
e Due Wed third week

e Activities:
o Initial rough draft of Section 2.
o Top-Level UI(s).
o Draft table of contents.

o Two scenarios per team member,
minimum two distinct screens per member.

o Updateadm n/ wor k- br eakdown. ht i

Slidd4
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Handout on Spec Doc Structure

Nt M contains linked contents

» Sections 1 through 6 are Iin the files:
olntro. htm
of unctional . ht m

onon-functional . htnl

odevel oper-overvi ew. hnt |
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Handout on Spec Doc Structure

| ndex. ht M contains linked contents

» Sections 1 through 6 are Iin the files:
olntro. htm
of unctional . ht m
onon-functional . htmn
odevel oper-overvi ew. hnt |
of ormal - spec. ht
orational e. ht m
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Doc Structure, cont’d

requi renents

| ndex. ht m

i ntro. htn

problem htm

functional . htni

ui -overvi ew. ht m

functional -section-X1.html

functional -sub-section-X1.1.html

non-functi onal . ht ni

devel oper-overvi ew. htn

— formal -spec. htm

Slide4
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Doc Structure, cont’d

e Ul -overvi ew. ht ml has section 2.1.
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Doc Structure, cont’d
e Ul -overvi ew. ht ml has section 2.1.

e Italic names, with prefixfinctional...", contain sub-
sections 2.2 throughr2.
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Doc Structure, cont’d
e Ul -overvi ew. ht ml has section 2.1.

e Italic names, with prefixfinctional...", contain sub-
sections 2.2 throughr2.

e Italic names stand for an appropriate mnemonic
name, e.gappt - schedul |1 ng for Sec 2.2.
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Doc Structure, cont’d
« Use additional files as appropriate for subsections.
* Rule of thumb for separate file is 7+/2 screens.
 Structure defined by HTMhr ef links.
 Top-level index has links to all (sub...)sections.

e Section indr has links to its subsections only.
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i ndex. ht ni
¢—— intro. htni _
o * - Titro subsections
o—— functional . ht m
¢ * » Ui -overview . ht ni
\ \ » functional-section-X1 . ht m
. functionai-sub- SectlonX11htn1
o o » functional-section-Xn.html . ht m
* » functional-sub-section-Xn.1 . ht m
e » nNon-functional . ht m
—— devel oper-overvi ew. ht m
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Doc Structure, cont’d

» Hyperlinking based on subsection hiergtch
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Doc Structure, cont’d
* Hyperlinking based on subsection hieratch
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Doc Structure, cont’d
* Hyperlinking based on subsection hieratch
 Files at same &l have'"next", "previous" links.
e Each file also has "up" link.

» Each file has "top" link to the index.
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Doc Structure, cont’d

e See the online Milestone 2 example In

http://users.csc.calpoly.edu/ gfisher/
classes/307/examples/milestone?2.
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Standard GUI Conventions
 Fallow these guidelines, or document your own.
 Style Is "simple charm", not flash.
 Emphasizes platform independence.

 Remember,
don’t bog down in minor Ul details early on.
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Main command menu

courier bold 12 point appropriate tool-specific name
intitle bars . o
additional tool-specific menus
courier normal 12 point ’/ /
in menu bars and item Tool Nane / O/
File Edit ©} Hel p click to iconify
drag to maximize/
Title O/ Wndow 1 Title minimize
Wndow 2 Title Of
2N
v
optional tool <L / >
palette(s)
dragtoresize
one or more

wor king windows
with tool-specific
contents

25% grey in scrolling arae

25% grey title bar for currently active window;
white title bar for inactive windows
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Il. Some paper OK for Milestone 2.

A. Clearly label paper materials
1. Figure number and caption.

2. Title for other notes.

B. Make oopies if you want originals.

C. To Hshers dfice by 5 PM Wednesday.
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Ill. Recap of General Scenario Guidelines

A. Present scenarios tatorial style.
1. Interesting, engaging, ultimately complete story

2. A step-by-step presentation.

B. Start with common activities.
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Recap of General Scenario Guidelines, cont’d

C. Separate based on user categories.
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C. Separate based on user categories.
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1. Leave nundane details until later.
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Recap of General Scenario Guidelines, cont’d
C. Separate based on user categories.
D. Stylistic recommendations:
1. Leave nundane detalls until later.

2. Leave aror details until later.
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I\VV. Core steps of the scenario process.
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I\VV. Core steps of the scenario process.
A. Describe a user action.
1. In GUIs, it’'s performed by some gesture.
2. Combo of mouse and/oeloard.

3. Most typically menu item, command button,
keystrokes.



CSC307-f15-L3 Slidé5

Core steps, cont’d

B. Show system response.
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Core steps, cont’d
B. Show system response.
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Core steps, cont’d
B. Shawv system response.
1. Typically appears on screen.

2. Can also be other output medium.
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Core steps, cont’d
B. Show system response.
1. Typically appears on screen.
2. Can also be other output medium.

3. In some cases, not displayed directly,
e.g., S8ed data store.
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Core steps, cont’d

C. Fully describe detalls of response.
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C. Fully describe detalls of response.
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Core steps, cont’d
C. Fully describe detalls of response.
1. A prose narrate.

2. All screen components described.
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Core steps, cont’d
C. Fully describe detalls of response.
1. A prose narrate.
2. All screen components described.

3. All output effects described.
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Core steps, cont’d

D. If response is input dialog:
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Core steps, cont’d

D. If response is input dialog:

1. Shawv another picture, filled In.
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2. Fully describe entered values.
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Core steps, cont’d

D. If response is input dialog:

1. Shawv another picture, filled In.

2. Fully describe entered values.

3. For non-atomic interactions:
a. Simple cases in narraé.

Slidg7
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Core steps, cont’d

D. If response is input dialog:

1. Shawv another picture, filled In.

2. Fully describe entered values.

3. For non-atomic interactions.
a. Simple cases in narraé.
b. E.g., toggles or short lists.
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Core steps, cont’d

D. If response is input dialog:
1. Shawv another picture, filled In.
2. Fully describe entered values.

3. For non-atomic interactions.
a. Simple cases in narraé.
b. E.g., toggles or short lists.

4. If input alternatves, cover all cases.

Slidg9
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Core steps, cont’d

E. If response Is output:
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Core steps, cont’d

E. If response Is output:

1. One example sufficient ftilly representative.
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Core steps, cont’d

E. If response Is output:
1. One example sufficient ftilly representative.

2. If alternatves, shaev additional examples and
narratve.
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V. Milestone 6 example excer pt
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V. Milestone 6 example excer pt
A. lllustrates completed scenarios, circa Milestone
B. This detall not expected for earlier Milestones.

C. It's what you are working teards.
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VI. Corestepsillustrated

A. Describe a user action:
Section 2.2, paragraph 2
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VI. Corestepsillustrated

A. Describe a user action:
Section 2.2, paragraph 2

B. Show the resulting screen:
Figure 6
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VI. Corestepsillustrated

A. Describe a user action:
Section 2.2, paragraph 2

B. Show the resulting screen:
Figure 6

C. Describe screen contents fully:

starting paragraph 2

Slid®0
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Schedul e an Appoi nt nent L] El
Title:
Dat e: Start Tine:
hr mn
Dur at i on:
Recurring?_]
Cat egory: V| Security:/public v
Locati on: Priority:| nmust \
Remi nd?[]
Detail s:
A
v

d ear

Cancel

Slid®1
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Core stepsillustrated, cont’d

D. If screen is input dialog:

1. Shov another filled-In screen.
Figure 7

2. Fully describe entered values.
paragraph 5
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Schedul e an Appoi nt nent L] El
Title:|Dentist
Dat e: | Sept enber 12, 2012 Start Tine:|8 AM
hr mn
End Dat e: Dur ati on: 1 30
Recurring?_]
Cat egory:|outside appt V| Security:|/title only V¥
Locati on:| 1342 Sycanore Dr Priority:| nust v
Remi nd?[X] | 1]|days before V] |on screen V¥
Det ai | s:
A
\

d ear

Cancel

Slid®3
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Core stepsillustrated, cont’d

3. Cover al non-atomic interactions
Figures8-11
narratve
paragraph 6 page 10.
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Cat egory:| ¢ none V]
hol | day

Edi t
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Edit Categories [1H]

Current Categori es:

hol i day

(

Add

)( Del et e ) ( Change )

( Done )




CSC307-f15-L3

Add Cat egory

LI H]

Cat egory Nane:

Col or:

Bl ack

A

([

j) (; Cancel )

Slid®7
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Add Cat egory

LI H]

Cat egory Nane:

out si de appt

Col or:

(o

Bl ack ;!J

Br own
Red

Cancel )

G een

Bl ue
Pur pl e

Slid®8
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Core stepsillustrated, cont’d

a. Simple cases, narrag aly.

b. E.g., toggles, short lists.
paragraph 1-3
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Core stepsillustrated, cont’d

4. For input alternaties, shaev additional fill-in’s
Figure 12,

narratve
paragraph 8 thru 10
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Schedul e an Appoi nt ment L] El
Titl e:| Racket Ball
Start Date:| Septenber 1, 2015 Start Tinme:[8 AM
hr m n
End Date:| Decenber 31, 2015 Dur at i on: 1
Recurring?)X] Interval :|weekly \ 5&1%&'\/%"55
Cat egor y:| per sonal V| Security:|title only V¥
Location:|rec centre Priority: optional V¥V
Renmi nd?[_]
Detail s:
Call Jimif you need to cancel, AN
V4

o )

Cl ear

Cancel

Slida01
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Core stepsillustrated, cont’d

E. For output screens:

1. One case, If adequately represengti
Figures 20 and 23,
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Weekl y Agenda

2: 30-4: 30

L1 El
{ Week of September 6 - 12, 2015
Sun Mon Tue wed Thu Fri Sat
6 7 8 9 10 11 12

9-10 AM O(8-9 AMRa|8-9 AM St |8-9 AM Ra | 8-9: 30 AM

10-11 AM |9 AM5 PM]8-9: 30 AMJ9-10: 30 A[9-10 AM O

11 AM 12 9-10 AM Of10: 30-12 [(10-11 AM

3-5 PM So 10-11 AM |1:15-2 PM|11 AM 12
11 AM12 |3-5 PM So
12-1:30 P
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Year |y Cal endar L1 E]
2015 D
Jan Feb Mar
S MT WT F S S MT WT F S S MT WT F S
1 2 3 1 2 3 4 5 6 7 1 2 3 4 5 6 7
4 5 6 7 8 910 8 9 10 11 12 13 14 8 9 10 11 12 13 14
11 12 13 14 15 16 17 15 16 17 18 19 20 21 15 16 17 18 19 20 21
18 19 20 21 22 23 24 22 23 24 25 26 27 28 22 23 24 25 26 27 28
25 26 27 28 29 30 31 29 30 31
Apr May Jun
S MT WT F S S MT WT F S S MT WT F S
1 2 3 4 1 2 1 2 3 4 5 6
5 6 7 8 9 10 11 3 4 5 6 7 8 9 7 8 9 10 11 12 13
12 13 14 15 16 17 18 10 11 12 13 14 15 16 14 15 16 17 18 19 20
19 20 21 22 23 24 25 17 18 19 20 21 22 23 21 22 23 24 25 26 27
26 27 28 29 30 24 25 26 27 28 29 30 28 29 30
31
Jul Aug Sep
S MT WT F S S MT WT F S S MT WT F S
1 2 3 4 1 1 [ﬁ 3 4 5
5 6 7 8 9 10 11 2 3 4 5 6 7 8 6 7 8 10 11 12
12 13 14 15 16 17 18 9 10 11 12 13 14 15 13 14 15 16 17 18 19
19 20 21 22 23 24 25 16 17 18 19 20 21 22 20 21 22 23 24 25 26
26 27 28 29 30 31 23 24 25 26 27 28 29 27 28 29 30
30 31
Cct Nov Dec
S MT WT F S S MT WT F S S MT WT F S
1 2 3 1 2 3 4 5 6 7 1 2 3 4 5
4 5 6 7 8 910 8 9 10 11 12 13 14 6 7 8 9 10 11 12
11 12 13 14 15 16 17 15 16 17 18 19 20 21 13 14 15 16 17 18 19
18 19 20 21 22 23 24 22 23 24 25 26 27 28 20 21 22 23 24 25 26
25 26 27 28 29 30 31 29 30 27 28 29 30 31

Slidd04
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Core stepsillustrated, cont’d

2. For dternatves, shev additional screens
and narratie, eq.,

a. Figures 13 -17
b. Figures 18 and 19

c. Figures 21 and 22.
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Dai | y Agenda L1 El
< Wednesday, Septenber 9, 2015D

8 AM | Staff Meeting

9 AM | Ofice Hours

10 AM | Data Structures Lecture

11 AM | Data Structures Lab
12 PM | Lunch with M crosoft

1 PM [
2 PM |
CAD Research Project Meeting

3 PM

4 PM [
5 PM
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Dai | y Agenda [1E]
<] Thursday, Septenber 10, 2015D

Racket Bal |

8AM
Picnic Day Comm ttee

9AM

10AM [~ormommmommmmmmmn e TTTTTTToTTmemmenes ST TTTTTTTmmmmmmmmmmmmmmmemmmmmnmmmmmmnmeeees
Sof t war e Engi neeri ng Col | oqui um

11AM

12PM

1PM O fice Hours

2PM

Sof t war e Engi neeri ng G aduate Sem nar
3PM

4PM

SPM
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Dai | y Agenda

my

{ Wednesday, September 9, 2015)>
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10-11 AM Data Structures Lecture
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11 AM 12 PM Data Structures Lab

[l o
NN
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12-1:30 PM Lunch with M crosoft

[

;00
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2:30-4:30 PM CAD Research Project Meeting
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Dai | y Agenda L1E]
<| vednesday, September 9, 2015D)
8 AM [ Staff Meeting TA Meeti ng

9 AM [ O fice Hours

10 AM | Data Structures Lectur

11 AM | Data Structures Lab

12 PM | Lunch with M crosoft

1 PM

2 PM

3 PM

4 PM

5 PM
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Dai | y Agenda L1 El
<| Wednesday, Septenber 9, 2015D
8 AM | 8-9 AM Staff Meeting
8-9:30 AM TA Meeti ng
9 AM [ 9-10 AM O fice Hours
10 AM | 10-11 AM Data Structures Lecture
11 AM (11 AM 12 PM Data Structures Lab
12 PM | 12-1: 30 PM Lunch with M crosoft
1 PM
2 PM
2:30-4:30 PM CAD Research Project Meeting
3 PM
4 PM
5 PM




CSC307-f15-L3 Slidd11

VII. Other scenario presentation issues
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VII. Other scenario presentation issues

A. Ensure complete verage.
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VII. Other scenario presentation issues
A. Ensure complete verage.

1. Cover all user interactions at least once.
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VII. Other scenario presentation issues
A. Ensure complete verage.
1. Cover al user interactions at least once.

2. Provide at least tawvexamples of all input dialogs
-- Initial and filled In.
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VII. Other scenario presentation issues
A. Ensure complete verage.
1. Cover al user interactions at least once.

2. Provide at least tawvexamples of all input dialogs
-- Initial and filled In.

3. Provide at least one example of all outputs.



CSC307-f15-L3 Slidd.16

Other 1ssues, cont’d

B. Interface layout details.
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Other 1ssues, cont’d

B. Interface layout details.

1. Not purely look and feel.
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Other 1ssues, cont’d

B. Interface layout details.

1. Not purely look and feel.

2. E.9.,2.3.1.1, paragraph 3
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Other issues, cont’'d
C. Avoid unnecessarily repetition.

1. Refer back to pictures and narvatfor common
functionality.

2. E.g., description of weekly weoptions,
2.3.1.2 paragraph 10
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Other issues, cont’'d
D. Scenarios flov with step-by-step examples.
1. Agalin, refer liberally to preceding sections.

2. State assumed user actions and refer forward.
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Other 1ssues, cont’d

E. Where necessargritty details.
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Other issues, cont’d
E. Where necessargritty details.
1. When functionality is complicated.

2. E.g., overlapping items
Figures 16-19 earlier
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Other issues, cont’d
3. Use judgment, 7+/-2 rule to defer detalls, e.qg.,

a. In Section 2.2, details of recurring items
deferred to Section 2.4.

b. Same for details of reminders.
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VIII. Interface styleissues.
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A. Be simple and consistent.
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VIII. Interface styleissues.
A. Be simple and consistent.

B. Use interface forms that end users can easily
understand -- calletaffordance" .

C. Provide interface options to allouser to select
among alternate forms.
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IX. Moreon “Interesting & Engaging Stories’
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IX. Moreon “Interesting & Engaging Stories’

A. Purpose Is two-fold:
1. maintain reades interest

2. provide werall context and continuity

B. Point is not to entertain l&ka rovd.
1. Humor should be used sparinglyat all.
2. Story should stick to the facts.
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“Interesting and Engaging Stories’, cont’d

C. Story outline for Calendar Tool scenarios:
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“Interesting and Engaging Stories’, cont’d

C. Story outline for Calendar Tool scenarios:

. User schedules a couple appointments.

. User views calendar in various ways.

1

2

3. User schedules some other kinds of items.
4. User deals with finer points of scheduling.

5

. Admin user performs specialized functions.
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“Interesting and Engaging Stories’, cont’d

C. Story outline for Calendar Tool scenarios:

. User schedules a couple appointments.

. User views calendar in various ways.

. User schedules some other kinds of items.

1

2

3

4. User deals with finer points of scheduling.
5. Admin user performs specialized functions.
6

. User sets calendar options.
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“Interesting and Engaging Stories’, cont’d

D. Story line sketch for TestTool:
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“Interesting and Engaging Stories’, cont’d
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1. Instructor creates a simple test.
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“Interesting and Engaging Stories’, cont’d

D. Story line sketch for TestTool:
1. Instructor creates a simple test.
2. Instructor edits guestion database.
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“Interesting and Engaging Stories’, cont’d

D. Story line sketch for TestTool:
1. Instructor creates a simple test.
2. Instructor edits guestion database.
3. Instructor creates more complicated test.
4. Student takes test.
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“Interesting and Engaging Stories’, cont’d

D. Story line sketch for TestTool:

Instructor creates a simple test.
Instructor edits question database.
Instructor creates more complicated test.

. Student takes test.

a h~ 0D PRE

Instructor grades test.
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“Interesting and Engaging Stories’, cont’d

D. Story line sketch for TestTool:

Instructor creates a simple test.
Instructor edits question database.
Instructor creates more complicated test.
. Student takes test.

Instructor grades test.

R T o A

Instructor manages tests and question DB.
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X. Concrete data underlying scenarios.
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X. Concrete data underlying scenarios.

A. Consistent example data.
1. Extensve enough to support all scenarios.
2. But, no more expang than necessatry.
3. Exemplify variety of realistic examples.
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X. Concrete data underlying scenarios.

A. Consistent example data.

Extensve enough to support all scenarios.
But, no more expang than necessary.
Exemplify variety of realistic examples.

Typically, no sngle scenario shows all data.

a k~ W D F

Appendix can she complete content.
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Concrete underlying data, cont’d

B. For data collections, scenariosganized into
data editing anddata viewing.
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Concrete underlying data, cont’d

B. For data collections, scenariosganized into
data editing anddata viewing.

1. Data-editing cueers add, modifydelete.
2. Data-viewing scenarios ¢er search, display.

3. Need a sufficient representagiexamples.
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Concrete underlying data, cont’d

4. Show representate cata added, then say:
"The user now proceeds to add more.... ."
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Concrete underlying data, cont’d

4. Show representate cata added, then say:
"The user now proceeds to add more.... ."

5. Subsequent editing and viewing scenarios shov
scenario-specific collection elements.
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Concrete underlying data, cont’d

C. Importance is continuity through story line.
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Concrete underlying data, cont’d

C. Importance is continuity through story line.
1. Early scenarios shwdata being created.
2. Then scenarios shosame data modified.
3. After that, scenarios present viewing.

4. In some cases, viewing scenarios may come fir
before editing detaills.
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Concrete underlying data, cont’d

a. Narratve says something like
"The following scenarios assume ... ."
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Concrete underlying data, cont’d

a. Narratve says something like
"The following scenarios assume ... ."

b. Continuity maintained by subsequent editing sce
narios using example data that appears earlier.
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Xl. Data examples.
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Xl. Data examples.

A. For this years 37 projects.
1. To provide continuity among scenarios.

2. Does not ceer data for all functionalitybut
major stuff.
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Project data examples, cont’d

B. For Calendar Tool, calendar examples for a num
ber of users, and for each of the databases.
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Project data examples, cont’d

B. For Calendar Tool, calendar examples for a num
ber of users, and for each of the databases.

1. Main example is work calendar for one user.
2. Also smaller examples for other calendars.
3. Also example calendars for other users.
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Project data examples, cont’d

B. For Calendar Tool, calendar examples for a num
ber of users, and for each of the databases.

1. Main example is work calendar for one user.
2. Also smaller examples for other calendars.
3. Also example calendars for other users.

4. One full example for each database.

5. Appendix with complete example content.
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Project data examples, cont’d

C. Underlying data for the TestTool:
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Project data examples, cont’d

C. Underlying data for the TestTool:
1. Need example tests and question bank.
2. Main test example used in most scenarios.

3. Smaller test and question bank examples for
details of test gen and sharing scenarios.

4. Choose on class as basis for all examples, e.g.
CSC 101 or 102.
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XII.  Screen maps.
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XII.  Screen maps.
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XII.  Screen maps.
A. Potentially helpful high-kel view of GUI.

B. Consists of thumbnails in cascading tree of com
mand selection.
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Screen maps, cont’d

C. Calendar Tool samples in detailed notes.
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Screen maps, cont’d

C. Calendar Tool samples in detailed notes.
1. Can sketch on big whiteboards or in halys.

2. Online, thumbnail images link into requirements

D. Screen mapsot required for CSC 307.
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Launch Calendar
Tool fromthe OS

Initial Screen

—
-

Choose File
in menubar

File Menu

Tarendar Toor

Edit__ Schedule View Admn__ Qptions

New
open
dose
Gose Al

\i

Choose Edit
in menubar

Choose Schedule
in menubar

o
-

Choose View
in menubar

Choose Admin
in menubar

-
-

Choose Options
in menubar

oy
-

Choose Help
in menubar

o
-

save
Save As
Save Al

Print

Exit

Edit Menu

I = T

Undo
Redo
Repeat

it

[GTendar_Tool

[Fire eaic

[ view admin_ ptions

Cat egori es

View Menu

[Tendar_Tool 08
[Fite et schedue [ ~crin options el p
Day
Veek ->
Month
Year
Next
Previ ous
Gto Date
Lists ->
Filter ->
Q her User
Wndovs ->
[CETendar TooT [}
[Fite Edit  schedule view [NVUEM options el p
Users
G oups
Locati ons
G obal Options ->
[CETendar TooT [}
[Fite et Schedule view Admn el p
Tines and Dates
Schedul i ng
Vi ew ng
[Tendar_Toor 08

[Fite edit  schedue view admin_ Qptions

out
Show Qui ck Hel p
Detailed Hel p

Slidd.98
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Choose Schedule
in menubar

Schedule Menu

[CTendar Toor

[Fie

s telp

Em Vo ot oo
poiniren

Cat egor i es

Choose Appointment
in Schedule menu

Choose Meeting
in Schedule menu

Meeting Dialog

S -1}

Choose Task
in Schedule menu

Possible Time!

=

Press Possible
Times button

-

Choose Event
in Schedule menu

Choose Categories ...
in Schedule menu

Event Dialog

Edit Categories Dialog

\i

T On|

Press Confirm

button
———

s List

Press Options
button

Slidd99
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XIlI. A view of requirements evolution
A. SVN log report and snapshots.

B. Reported bysvn | og’.
1. Bookkeeping at top.

2. Versions rl through r8.
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Requirements evolution, cont’d

3. Log messages from fri argument to
‘'svnh comm t .

4. History for 'menus. 1 dr".

5. For images, check in source file and/or binary.
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Requirements evolution, cont’d

C. Excerpts from SVN log report:

Repl aced ‘ Adm n d obal Options’ with ‘Central Host’, ‘List Adm ns’,
and ‘Login’. Also added 'View Today’', 'View Wndows C ose’, and
‘“File Save Config’.

Added an "AIl Itens’ itemto 'View >Lists’ subnmenu. Nuked subnenus
for Adm n User, G oup, and Roomin favor of uniformdialog for each.

rl | gfisher | 2015-04-10 14:51: 35
I nitial checkin.
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D. Here are a couple screen shots:
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Cal endar Tool

Version 1.1:

Slideo4

Of
File Edit ,Schedule View Adnmin_ Options__ Hel p
New oo R Ti mes and Dates
Open ... Lo R Voo Cat egori es
Cl ose K P PR .| Views
O ose Al I Voo
Save ; R ' ".
Save As ... R ;o oo
Save All S Voo ASEAR
Print ... . N >
Exit Appoi nt ment Dai l'y Users ->
; Meeti ng Weekl y G oups ->
’ ; Task Mont hl y Roons - >
Undo Event Yearly G obal Options ->F-..
Redo gext - S
Repeat : revious Times and Dates
Qut E I(_BIOtSt § -3 Cat egori es
!/ 0 ...~ _ .
Copy ; Filter ... Appoi nt ment s N M eve
Past e K h . Meet i ngs
, O her User . =,
Del et e ; W ndows - > N Tasks
Sel ect All ; .. | Events
Find ... ! N
Command . ..
Cat egori es
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CSC307-f15-13 Version 1.8:
Cal endar Tool E10
File Edit Schedul e View Admin _ Options. Helpf...._
New R . About
Open ... Lo [ Voo ISR Show Qui ck Hel p
d ose FE I Voo K Detailed Help ...
Close Al ;oo Do Voo .
Save FE Vo IAEN
Save As ... Y v
Save All S R Vo . . ..
: Do Appoi nt nent B Users Ti mes and Dates
Save Config ... FE : Meeting ... | G oups Scheduling ...
Print N ',' '.' Task ... ' ‘\‘ Locati ons Vi ew ng -
rent ... S : Event | Admi ni strative
Exi t . ' Central Host
; ! : Cat egori es \ Li st Adni ns
: : Logi n
‘ Item
Day | .
Week ->77TTTTTTTT
Month TTteel Tabl e
_______ Lists

Undo
Redo
Repeat

Cut
Copy
Past e

Del et e
Sel ect All

Find ..
Conmand

Next

Today
CGoto Date . ..~

v

Lists ->{_
Filter ->:-

s

Pr evi ous

O her User . ..

All

" | Appointnents
Meet i ngs
Tasks
Events 3

ltems |,

i Edi t

G oup
W ndows -3,

i Hi de Appoi nt ment s
\ H de Meeti ngs
. | Hi de Tasks

H de Events

d ose

W ndowi ng Mbde -3

Magneti ze

Edi t

| Two- W ndow
Per - Level
Mul ti - W ndow
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